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装置使用の前に
以下のルールを守って下さい。
• 研究室内は土足厳禁、飲食厳禁
• 装置の故障、不具合を見つけたらすぐにスタッフに連絡
• 装置を乱暴に扱わない
• 研究室の物品を勝手に持ち出さない

• 貴重品の管理は各自でする。休日や夜間利用の際、研究室
の施錠は各自で行う

• ステージの移動操作時、ステージ位置稼働制限を守る。動か
し過ぎると試料が検出器などにぶつかり、故障します

• ソフトウェア、ハードウェア上のパラメータを変更した場合、装
置使用後に必ず設定を元に戻す

• 装置PCに直接自分のUSBメモリ等の記録メディアを差し込まな
い。当研究室専用のUSBメモリを利用し、解析用PCを経由して
データを取り出す

• 分析室内に導入するものは素手で触らない。汚した場合は備
品を利用して自分で洗浄する

• 使用者が予約を取って、予約時間通り使用する。変更の場合
は前日までにキャンセル。当日の予約キャンセルは無効

• 装置利用中の故障トラブルは全て貴研究室の責任です。装置
利用について自分の指導教官に必ず知らせておくこと

• 初めて装置を使う際は職員に連絡を取って講習を受けること

• ガスが出やすい試料、大きすぎる試料、壊れやすい試料など、
分析室真空度を劣化させる試料は勝手に入れず、事前にス
タッフに相談する

• トランスファーベッセルを使用する場合、必ず施設職員に連絡
し許可を取る

• 20 kV 以上の加速電圧を使用する場合はいきなり上げず、
10→15→20→25→26→27→28→29→30と徐々に昇圧すること

2



装置使用の前に

使用記録簿に日時、開始時間、
氏名、研究室名、分析室真空度
(使用前)、試料情報、ナノテク番号
を記載してください

ボールペンを無くさないように

分析室真空度、イオン化室真空度の
値を確認してください。異常に劣化して
いる場合はスタッフにご連絡ください
平常時：分析室10−7~10−8Pa

  ：イオン化室0.1 × 10−2Pa

AESのPC・ソフトウェアは常時立ち上

げたままになっています。ディスプレイ
の電源だけをつけてください

SEMソフトウェア、オージェマスター

が消えている場合は立ち上げ直してく
ださい

AES解析用PCと装置PCはネットワーク接
続しています。デスクトップ上の「AES-PC

ショートカット」アイコンから開いてデータを
回収して下さい。デスクトップ上の
「VMware Workstation」を開き、Linux OS上
で「Auger master processing」を開けば、装
置PC内のデータ編集などが実施出来ます。
装置PC内データのアドレスは
「home/aes/AESData/Desktop」です。 3

分析室真空計

AES解析用PC



試料の準備

オージェ分析ではコンタミ(試料汚染)が

分析に強く影響を与えます。出来るだけ清
浄な表面を用意して下さい
• 出来るだけ大気非暴露な環境で保存

• 超音波洗浄(純水、エタノール、アセトンなど)を行

い、エアーガンなどで即座に乾燥。さらにホットプ
レートなどで加熱する

• 断面観察の場合はクロスセクションポリッシャ(CP)
で平滑で清浄な断面を出す

• 埃やゴミはブロワーでよく飛ばす

• 利用するホルダーも洗浄や加熱を行うとコンタミ
除去に有効です

ホルダーは以下の三種類↓
• 小型ホルダー(試料サイズ：厚み

4mm×12mmφ以下)

• 大型ホルダー(試料サイズ：厚み
5mm×20mmφ以下)

• 断面観察用ホルダー(試料サイズ：厚
み7mm×11mm×10mm以下)

大型・断面ホルダーはチルト角度制限があり、
55度までしか傾けられません。EBSD測定の際は
小型を選択

AES試料ホルダーは真空デシ

ケーターに保管してあります。ポ
ンプは常時稼働なので、大気側、
ポンプ側バルブを開け閉めして
取り出してください

大気側：開
ポンプ側：閉

小型大型断面
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試料の準備

小型ホルダーの横ネジを
外すと、ホルダー蓋部が外
れます。蓋部は2種類あり
ます

ホルダーの底と蓋で試料を挟み込むように
固定します。厚みがある場合は蓋部を分解し
てから試料を入れてください
• 固定したらホルダーを振ってみて固定出来ているか確認
• ネジ類はしっかり固定、ネジはなくなさいように

大型ホルダー
も分解可能です。
蓋は3種類あり
ます

断面観察用ホルダーは試料を左図の
ように挟み込みます。ホルダー下部に試
料を接地した方が安定します
• サンプル断面をホルダーより少し迫り出して固定

固定が不十分な場合、または粉末試料な
どはカーボンテープなどで固定してください。
使用後はホルダーを洗浄して下さい
• 試料のドリフトが気になる場合はペーストを使ってください。使
数時間真空引きする事

• カーボンテープ他、銀ペースト、カーボンペースト、銅テープ、
普通の両面テープ、瞬間接着材などがあります
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試料の導入

ホルダーの下の溝にフォーク
を差し込みます

試料導入室ドアのロックを
外します。VENTボタンを押し
て導入室を大気に戻します

VENTボタンを押すと緑に光ります

導入室内のフォークにホル
ダーの上の溝を差し込んで、
マグネットリングを回して
「CLOSE」を上にします

手に持ったフォークを抜き
取り、ドアを閉め、ロックをか
け、再びVENTボタンを押して
導入室を真空に引きます

導入室でしばらく真空に引き続けます
目安：金属板一枚なら30分、粉末試料なら2時間ほど

装置のオペレーター板の扉を開け、導
入室の真空度を確認します。針が端に
届くまで真空を引きます

上げてから回す

導入室の上からも
中が覗けます

回しすぎない

これはまだ真空が引けます↑
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試料の導入
真空を引いている間に、
オージェマスター →file→saving 
conditionでデータの保存先、保
存名を決めます
• 画像・スペクトルデータは保存名+連番で自動
保存されます

• 保存名は6文字以内です

• ディレクトリ名などに漢字や変な記号、空白を
入れると文字化けなどバグが起きます

オージェマスター→ observation → 
sample  manipulation を選択

Special Positionをクリック

立ち上がったウィンドウから
Sample Change PositionのMoveをク
リック。New holderからホルダーの
種類を選択し、Close

小型→12mm  大型・断面→20mm

・ビームシャッターが閉じている
・PCDが入っている
・二次電子検出器がOFF
を確認

SEMのコントロール画面が消えてる場合
はこのアイコンをクリック

下についてる棒を回す

閉まってます
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ビームシャッター PCDアイコン
緑色In 灰色Out

二次電子検出器



試料の導入

分析室の窓蓋を外して分析室
内を確認します

マグネットリングが後ろ端まで来ているのを確
認し、V2ボタンを押してV2バルブを開けます

マグネットリングが後ろ端まで来てないと開きません

分析室を覗きながら、マグネットリングを押し出
して試料をステージに入れます。マグネットリング
を「OPEN」へ回し、フックが外れたのを確認してか
らマグネットリングを後退させます

V2ボタンを再度押し、V2バルブを閉めます。外
した窓蓋を付けます

分析室の真空度を確認します。真空度が
5.0×10−6Paより悪い場合、試料を回収して導入
室で真空を引き直してください

5.0×10−6Paより真空度が良い場合はそのま
ま真空引きを続け、10−7Paオーダーまで真空を
引いて下さい
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試料の観察

真空が10−7 Paオーダーに到
達したら、ビームシャッターを開
けます。オージェマスター→ 
observation →probe condition選
択、OL→Lens Clear→OLをクリッ
クして消磁

電磁レンズのヒステリシスを消磁してま
す。ヒステリシスが残ってると軸合わせや
オージェ分析に支障が出ます

開いてます

Probe Energyに電子ビームの加速電
圧、Auto Probe Currentに電流値を入
力し、Setボタンをクリック
• 普通に使う場合は10 kV ,10 nA推奨
• 20 kV 以上に昇圧する場合、10→15→20→25→26→27

→28→29→30と徐々に数値を上げるようにして下さい
• 電流値が大きいとオージェ分析でS/N比向上します
• EBSD時は15~20 kV 推奨、電流値大き目
• 20 nA以上にする場合は対物絞り番号の変更が必要
• 微小領域を観察する際は電流値下げる

電圧・電流値の設定後、
PCDをOut、二次電子検出
器をOn
検出器Onと同時に分析
室真空計はOffになります

SEM像が観察出来ます

観察したい場所へステー
ジを移動

大きく移動する場合、サンプル
が中で何かにぶつかる事がない
よう細心の注意を払う事

X,Y 移動 Tilt/rotation

Z移動
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試料の観察
オージェ分析を行う場合 or Ar+イオンガンを使う場合

・ユーセントリック位置へ移動する

①tiltを１０度に傾ける
②観察する場所でターゲット(見やすいもの)を
画面中心に移動させる(ｘｙ操作で)
③tiltを３０度に傾ける。その時ターゲットがSEM
画面で上に行ったか下に行ったか確認(横の移
動は無視)

④上に行った場合ｚを下げ、下に行った場合ｚ
を上げてターゲットを元の位置まで戻す
①~④までを50倍くらいから徐々に上げて1500
倍くらいまで合わせる(最後はtilt30度のまま)

• 観察場所を大きく動かした場合はもう一度ユーセン
トリック位置の修正を行います

• ユーセントリック位置からずれてるとAr⁺イオンガンで
うまく削れません。オージェ分析の強度も落ちます

・反射電子検出器の使い方(COMPO・TOPO像観察)

Tilt軸0度の状態で二次電子検出器Off

にし、ステージを覗きながら装置後部の
反射電子検出器導入バルブを、留めネジ
を緩めてからIN側へ止まるところまで回す。

検出器が入るのを目視確認する。以降
Tilt操作禁止。ぶつかります

2次電子検出器をOnにし、SEMソフトウェ
アの右下、SEIの表示をクリックして、
COPMOかTOPOを選択
• 利用後は必ず撤収する。入れた事を忘れないで下さい
• 電流値1nA程度がお勧め。大体数100nmの深さを見てます
• TOPO像は画面の上に光源があるような陰影がつきます
• COMPO像は重い組成が明るく、軽い組成が暗く見える

留めネジ緩める

①

②

③

③
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反射電子検出器導入バルブ

反射電子検出器

④



軸合わせと撮影
電子ビームの軸合わせを行います。観察
箇所でスキャンモードをRDC imageに切り替

えて、倍率・フォーカス・コントラスト・ブライト
ネスを調整

５千倍以上での観察の場合、さらにスティ
グマXYの調整します

スティグマがずれているとデフォーカス時のぼやけ方が一
方向に伸びたようになります。デフォーカスしてみてぼやけ
方が同心円状になるか確認しましょう

数万倍での観察の場合、さらに対物絞り
XYの調整をします(電圧電流値を変えたら
チェック)。HTウォブラをOnにし、周期的にぼ

やける画像の視野位置がズレないように対
物絞りXYを調整します。終わったらウォブラ
はOｆｆにし、フォーカス・スティグマを再調整

対物絞りの番号は通常4番で高倍率観察用になっていま

す。絞り番号を小さくすれば、電流値をさらに上げる事が出
来ます。番号を変えた時も対物絞りXYの調整が必要

・SEMコンソールの説明
FINE VIEW：スキャンスピードを遅くし、精細な像が取れま

す。スピードは2段階あり、ボタンを押すと切り替わります

FREEZE:スキャンが1周終わった時に像が固定出来ます

PHOTO:FINE VIEWが始まり、スキャンが終わるとFREEZEし、

SEM像を保存するウィンドウが立ち上がります

エクスポートをクリックし、クイックアクセス
からDesktopを選択、AES-PC内の自分のフォ
ルダに移動して保存します

AES-PC内の画像データはAES-PCデスクトッ
プ上の「AESdata」→「Desktop」から各自の
フォルダにアクセスして見る事が出来ます

RDC image

スティグマ

コントラスト
ブライトネス

X軸

Y軸

絞り番号変更
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HTウォブラ

対物絞り
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試料観察で使う機能

SEMモード番号は照射電流量が大きい場合
(10nA程度)は0番。小さい場合(0.1nA程度)は3番
に変更するとSEM像が見やすくなります

スキャンローテーションをONにしてスク
ロールを操作すると、像が回転します
ダイナミックフォーカスをONにしてスク

ロールを操作にすると、高低差のあるも
のでも全体のピントが合いやすくなります

パレットボタンをクリックするとSEM像

上にテキスト書き込みや、ルーラーで物
のサイズなどを測って保存出来ます

ステージ移動せず、SEM像上でマウスド

ラッグして像を動かす事が出来ます。動か
せる範囲はSample ManipulationのImage 
Fine Shiftの範囲までです(上下左右10μm
程度)。初期値(原点)に戻す場合は、←左
図のアイコンをクリックします
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Image Fine Shift

SEMモード番号

パレット

2画面、4画面モードが

あります。反射電子像と
SEM像を同時に見る事
が出来ます

シフトリセット



試料観察で使う機能

試料を観察中に像が動いてしまう場合
• BACKLASHボタンを押し、BACKLASHを
解消する

• 分析室に導入してしばらく待つ

• 帯電に起きている場合は電圧電流値、
ステージポジションを調整

• 試料セッティングをやり直す

現在のステージ位置を記憶させたい場
合は、Save PositionsのAddをクリック。複数

のポイントを記憶出来ます。呼び出す際は
Detailをクリックし、テーブル中のNumberを
選択し、Moveをクリックします
使い終わった後はposition dataを全部消
去して下さい。注意して使用すること

スポットボタンを押すと青色の十字が像
上に出てきます。もう一度押すと十字が黄
色に変わり、ビームがスキャンモードからス
ポットモードに変わります。十字の中心部
のみビームを照射します。その間、像はフ
リーズします

低倍率だとスポット位置が指定位置から若干ズレます

スポットモードでビームを照射しながら簡易的にオージェ
の点分析をかける事が出来ます→分析点指定をscanに
変更、分析したい箇所に十字を動かす

13BACKLASHボタン

このボタンでもセーブ
位置に動くので注意

スポットボタン



Ar⁺エッチング
Aｒ⁺イオンビームを照射し、試料のコン

タミ除去や酸化膜除去が行えます。分
析だけでなくSEM観察にも効果的です
化学状態分析を行いたい場合にはビーム照射の影響で材
料の還元、アトミックミキシングなどが起こるため、利用しな
い方が良いです
• EBSDのカメラや反射電子検出器を導入している場合は使
用禁止

• ユーセントリック位置にいないとイオンビーム照射位置が
観察位置からズレます

・Arガスの導入
分析室真空度を確認！真空度が悪い場合は導入しない

真空度が著しく悪化、またはエラーなどが発生した場合はすぐに
Arガスバルブを締めて下さい。向きを間違えないで下さい

1. Arガスバルブを反時計回りにゆっくり回
し、イオンガンの真空計で約10.0 ×
10−2Paまで上げる
通常6時の方向に目印があり、一回転ほどでその値になり
ます。出し過ぎに注意！

2. オートバルブコントローラースイッチをOn
3. オージェマスター→AES→Ion Gun 

Conditionをクリック
4. 「Etching」で使用するChannel番号選択。
「Stage Rotation」でOffかOne-wayを選択

One wayはステージを回転させながら照射します。通常Off

5. 「Auto Valve Control」に8.0と入力し、
Setをクリック

6. ガス圧が指定値に落ち着くのを待つ

・Ar+イオンを照射
1. 「Etching」でエッチング時間を指定
2. 「Etching」のOnボタンで照射開始

観察位置を中心におおよそ1×1mmの範囲が削れます
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イオンガン真空計

Arガスバルブ

オートバルブ
コントロー
ラースイッチ



中和電子銃を利用する
低速のAr⁺イオンを照射する事で分析箇所
周囲の－電位を緩和します
「Ar⁺エッチング」を参照にArガスの導入、ガ
ス圧調整を行ってから、Neutralizingメニュー
で中和電子銃のChannelを設定し、Onボタン
をクリック
照射したままスペクトルを取得します

分析箇所周囲の帯電を抑えるのに有効ですが、分
析箇所の帯電についてはステージ傾斜が有効です

帯電しやすい試料について
試料の導通が取れないような試料の場合、電子ビームの照射により試
料表面が一般にはマイナス電位に帯電します。SEM像及びスペクトルの取

得が困難になります。オージェでは分析深さが非常に浅い故に、カーボン
や金の蒸着も分析上困難な為、他の手で帯電を緩和する方法を取ります

照射電流、スペクトル取得の設定
• 出来るだけ電圧、電流量を下げる

• スペクトルを取る際はプローブ径を大きくする
か、電子線をデフォーカスして測定

• スペクトルが帯電によりチャージシフトを起こし
ているか、安定しているか予備測定で細かく
チェックする

Ch11からCh14まで各種ビーム設定の
用意があります。Ch14は少し削れます

試料やステージのセッティング
• カーボンテープやペーストを利用して試料の導通
が取れる固定を行う

• アルミホイルで分析箇所以外をマスクする
• 絶縁体のゴミや過度な凹凸を除去する
• ステージを高傾斜(tilt80度ぐらい)する事で2次電
子の放出量を増やし、－電位を緩和する
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アルミホイルでマスク

プローブ径の設定(μm)
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酸化、汚染しやすい試料について
試料が酸化しやすい、コンタミが付着しやすい場合、分析中でもピーク
強度などに変化が生じてしまいます。対策として、汚染源・水分の付着が
あるホルダーの洗浄と加熱が有効です。試料も洗浄や加熱が可能であれ
ば併せて実施して下さい

• ホルダーをエタノールで超音波洗浄
（ホルダーを超純水で超音波洗浄）

• ブロワーなどで乾燥させた後、ヒーター、
ヒートガンなどでホルダーを100度以上に加
熱(出来るなら試料も搭載）

• 冷える前に温かいまま試料準備室へ導入
(冷えるとまた水分などが付着します)

• 分析時、コンタミ(炭素)の増加や酸素の増
加傾向を予備測定などで確認

電子線照射に弱い試料について
熱に弱い試料などでは電子線照射により、表面形状が崩れたり、
ピーク強度に変化が生じる場合があります。試料準備の段階、また
は分析条件を調整して影響を緩和させます。アルカリ金属、アルカリ
土類金属、ハロゲン類は電子線照射の影響でピークが減衰する事が
多いので、予備測定や繰り返し測定で影響の度合いを確認しましょう

• 電子線条件を変更。基本的に電圧・電流値を
下げていく。電圧は目的のピークエネルギー
の10倍程度に設定しておくとS/N比が良いです

• Probe dia.を設定し、プローブを広げて分析、ま
たはエリア測定にする

• カーボンコートを薄く実施したり、目的面以外
を導電性コーティングするなどして、熱を逃が
すような工夫をする

ヒーター

ヒートガン

カーボンコーター



オージェ分析
分析方法には主に以下のような種類があります
• wide scan ー 広いエネルギー範囲でスペクトルを取得、主に元素分析用
• split scan ー 特定元素のエネルギーエリアだけを測定、主に状態分析用
• line profile ー 線分析。特定元素のpeakとbackgroundの強度を取得し、

ラインプロファイルを作成

• spectrum line profile ー線分析。特定元素のエネルギーエリアを測定し、

強度を計算、ラインプロファイルを作成

• depth profile ー 深さ方向分析。Ar⁺エッチングとスペクトルスキャンを繰り返す

• auger image ー 特定元素のpeakとbackgroundの強度を取得し、元素マッピング

• spectrum image ー視野内の全ピクセルがスペクトルデータを持つデータ
 キューブを作成。マッピング画像を再構築する

分析の為に設定しなければならない事、やっておかなければならな
い事は主に以下の項目です
1. 分析エリアの取り込み ー オージェマスターで分析エリアを取り込む
2. 分析条件の設定 ー 分析モード、測定するエネルギー範囲、ステップ、積算

時間、積算回数、オートプローブトラッキング間隔を指定

3. 分析箇所の設定 ー分析する場所をpointかareaで指定。分析時のビームの

 スポットサイズも指定出来ます 

4. ROIの設定 ー 測定する元素の指定やpeak＆backgroundを指定する

5. イオン銃の設定 ー イオンビームの出力や照射時間を設定、帯電時に使用
する中和銃を設定する

6. Auto probe trackingの設定 ー 測定中に分析箇所の画像を取得し、取込
時の画像と比べてずれている場合にビーム
シフトを行い、元の測定位置に修正します。
試料が動きやすいor高倍率or長時間での
測定の場合に使います

7. 予備測定 ー 本測定の前にスペクトルを収集し、スペクトルが安定しているか

確認します。データには残りません

8. 本測定 － 積算をかけてスペクトルを取得します。積算回数などを途中で変更
 する事が出来ます

17



オージェ分析 wide scan

１．分析エリアの取り込み
Observation → Start digital scanでSEM像
がオージェマスターに取り込まれます

解像度、積算回数、取り込み範囲をオージェマスター左
のメニューで変更できます 

２．分析条件の設定 
AES → Spectrum → Wide Scan Spectrum
でwide scanのウィンドウが立ち上がります

Wide scan Spectrum → Conditions→
Analyzerを選択

・Analyzer mode選択
M1：エネルギー分解能が測定エネルギー値によらず一定、パスエネ
ルギーを指定する。値が小さいほど分解能良い。基本使わない
M2～M5：エネルギー分解能が測定エネルギー値に比例して下がる。
M2が0.05%、M3が0.1％、M4が0.35％、M5が0.5%となり、番号順で
悪くなるが逆に強度は高くなる。M2,3は主に化学状態分析時、M4,5
は組成分析時に使用

・Wide Scan Conditions設定
測定したいエネルギー範囲指定
ステップ間隔、積算時間、積算回数指定

積算回数は測定中に変更可能
ステップは組成分析時：1.0 eV 化学状態分析時：0.2 eV 推奨

・Auto Probe Tracking設定(利用時)
Probe trackingを何回ごとに行うか設定

設定が終了すると測定時間がWide Scan 
Spectrumウィンドウ左下に表示されます

18



オージェ分析 wide scan

３．分析箇所の設定
Wide scan Spectrum → Condition→ 

Analysis Position で取り込んだ画像か
ら分析箇所を指定

3. 分析箇所を指定
4. Probe Dia.とResolutionの指定

probe dia.を0にしていると一番小さいビーム径にな
ります(大体10 nm )。それ以外の値を入れると指定
したビーム径( μm )に広がり、広範囲に分析する事

で平均的で安定したスペクトルが取得出来ます。
ビーム径を広げる場合は事前にSEMコンソール中央
上の「wobb」ボタンを押し、OLウォブラ(HTウォブラで
はない)をかけながら対物絞りXYを調整すると、ビー
ムが広がった際に位置ズレがおきにくくなります

６．Auto probe trackingの設定(利用時のみ)

Image Fine Shiftを利用して測定中、試料の位置ズレを補正します。
1万倍程度で分析位置を細かく指定する分析では利用して下さい。
予め 、Image Fine Shiftを原点に戻してオージェマスターへのSEM像
取得を行っておくこと、初めからImage Fine Shiftが動けるエリアぎり
ぎりの位置にいると上手く使えません

AES→Probe tracking control を選択
File→ReloadでSEM像を取り込む
AutoをOnに切り替える
解像度と積算回数を適当な値に指定
Correct Pos.を押して正常に働くか確認

19

・分析箇所の指定
1. 画面下1~20番のチェックボックスを
押す

2. Scan mode選択
Scanを選び、SEMでスポットモードを使ってSEM画

像中でスポット位置を操作する事で、簡易的に分
析箇所を指定出来ます

左：元画像 右：取得画像



オージェ分析 wide scan
７．予備測定

Wide Scan Spectrum →Preacquisition
→Startで予備測定が始まります

上側に測定スペクトルが表示され、下側にその微分
形が表示されます。青色が一つ前の測定で赤色がリ
アルタイムの測定です。スペクトルの形状が安定して
いれば本測定に移れます。この測定データは残りま
せん。Stopしないと永遠に続きます。出来れば全ての

分析点を予備測定して確認してください。
Preacquisition→Restartから分析点を変更出来ます

・スペクトルがいつまでも安定しない場合
✓ 試料が動いている
✓ チャージが起きている
✓ 試料がビームのダメージで変質している、還元している
✓ 分析点が相の中間になっている
✓ コンタミネーションが付着している
等々が起きている可能性があるので除外していきましょう

・Auto probe trackingを使う場合
予備測定中にもProbe trackingが働くので、
どのくらい位置ズレが起きているか確認

狙っている分析エリアに対して測定中の移動量が大き
い場合、トラッキングを仕掛ける間隔を早くして下さい。
(左のシフト量単位はμmです)

８．本測定
Wide Scan Spectrum →acquisition

→Startで本測定が開始します
途中で止める場合はStopを選択。Pause

で止めると電流量やステージ位置などの
パラメータを変更後、再開出来ます

装置にもたれかかったり、大声で騒いだりすると分析
位置がずれます。静かにしましょう

20
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オージェ分析 split scan

２．分析条件の設定 
AES → Spectrum → Split Scan 

SpectrumでSplit scan ウィンドウが立ち
上がります。Analyzer Conditionの設定
はwide scan参照

４．ROIの設定
Split Scan Spectrum →Conditions 

→ROI  Condition(split)でROIウィン

ドウが立ち上がります。一つ前に
取ったWideスペクトルが表示され
ます。下のROIテーブルから測定し
たい元素を指定or入力し、番号の

ボタンをクリックします。スペクトル
上に測定範囲が水色で表示され
ます

ROIテーブル内容を更新登録する際は
Enterボタンをクリックして下さい

表示のスペクトルを確認しながら
各元素の測定範囲を調整します。
他、積算時間やスイープ回数、
Step幅も指定します

スペクトルの表示拡大はResizeをクリックし
てからマウスで拡大が出来ます。ROIの設定
に戻る場合はROIをクリックします。また別の
スペクトルを参照したい場合はFileからデー
タを指定して開き直せます

 

Selected ROIをクリックすると各元素の測
定回数を変更出来ます
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ROIテーブル

以下の項目以外はwide scan参照



オージェ分析 line profile

２．分析条件の設定 
AES → Line Profile → Line ProfileでLine Profile
ウィンドウが立ち上がります。Analyzer modeと
Auto Probe Trackingを設定します

４．ROIの設定
基本的な操作はsplit scanを参照
ここではLine Profileの強度を作るPeakと

Backgroundを２つの方法で設定します。強
度の定義についてはInt.Def.から選択します。
基本(P-B)/Bで問題ありません

Bで割る事で、分析箇所の凹凸による影響を緩和してます

・PB別(Separate)法

指定したピークとバックグラウンドのエネ
ルギー値の強度をそれぞれ測定します

Sampling MethodでSepareteを指定し、測

定元素を設定後、各元素についてピークと
バックグラウンドのエネルギー値を指定しま
す。スペクトル上の水色表示のバーでは左
側バーがピーク、右側バーがバックグラウ
ンドです

PB同時法に比べて設定が楽です。ピークが見えていれ
ば問題なく取れますが、PB同時法より測定時間がかかり
ます。Pが小さく、右上がりのBよりも強度が低い場合など
は取れません。またPとBの設定を後から変更する事が出
来ません
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BackgroundPeak

以下の項目以外はwide scan参照



・PB同時(Simultaneous)法
PとBを別個に測定せず、７つある
検出器にそれぞれPとBの担当を決
めさせて、同時に取得します

Sampling MethodでSimultaneous
を指定、元素を指定後、CEMボタン
をクリックするとP/B Simultaneous 
Conditionが立ち上がります

オージェ分析 line profile

上の例では-3chと3chをBと指定、他をPと設定しています。基本的に0chをピーク中心に持ち込み
(スペクトル上のバーを動かす事で指定出来ます)、Epに適切な値を入れて-3chと3chをBに届くように

すると良いでしょう。ピークが低エネルギー側に裾野を広げるタイプの場合は高エネルギー側だけを
Bにして残りをPにすると良いです。またP/Bの他Noneを指定して測らないという事も設定出来ます
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CEM
・CEMの設定
測定する元素のピークが見えやすいように表示の幅を調整
analyzer ModeをM1に変更し、Epの値をRangeがPeakとBack両方
が-3chから3chの間に収められる幅になるよう整える

-3chから3chまでの7channelは各検出器の名称です。下の数値は各検出器が測定するエネ
ルギー値です。Ep(パスエネルギー)を変えると7つの検出器が測定する全体のRange(エネル
ギー幅)が変わり、測定するエネルギー値もそれぞれ変わります

各チャンネルのエネルギー値を整えてそれぞれPeak担当、Back
担当を割り振る。Gain value calculation energyにBack(3ch)のエネ
ルギー値を指定
順次、各元素でCEMを設定する



オージェ分析 line profile

３．分析箇所の設定
Line Profile→ Condition→ Analysis 

Position で取り込んだ画像から分析する
ラインを指定します

Directionで縦軸か横軸かを指定し、
Resolutionで解像度を指定します

例えばSEM像全体が5 μmほどの幅で解像度を256に
設定すると1stepあたりが20 nm ごととなります。オー
ジェの分析径はおおよそ10~20 nm なのでstep幅はこ
れ以上小さくしてもあまり精度が上がりません

画面端から端まで分析する場合、分析エリアの取り
込みは倍率300倍以上にして下さい。それより広域にな

ると画面中央と端で信号感度が大きく変わり過ぎて結
果に影響します

あとはwide scanと同じです。予備測
定はありません

Select PBをクリックすると積算回数を
各元素ごとに変更出来ます

例えば(P-B)/BはPB同時法ではBを2点以上で取っ
ている場合、Bで一次線形関数を作成し、各Pの強度
を差し引いた後、Bの平均値で割り算しています。そ
の結果をスキャン度に積算しています。Processing
でデータを読み込む時とinvestigatorでデータを読み

込む時でマッピングの絵の様相が変わる場合があ
りますが、これはprocessingでは上記の計算とは異
なり、P,Bそれぞれの全積算の合算とチャンネル数
比を用いた強度算出をしている為です。Investigator
では測定度にBの一次線形関数の作成を行ってい

る強度計算をしており、試料凹凸の影響をきちんと
補正した結果を表出しやすいです。またInvestigator

では、ノイズレベルの信号だと閾値で判断されたピ
クセルを強度０として像を作ります
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上：P/B intensity
下：Line profile
横軸はどちらもPixels



オージェ分析 spectrum line profile

１～３．wide scan, Line profile 参照
４．ROIの設定はsplit scanを参照
６～８．wide scan参照

Spectrum Line ProfileはLine Profile
と異なり、PとBだけを取得するのでは

なく、各元素のスペクトルを収集後、
微分形からピークの強度を読み取り、
各ピクセルの分布を表示します

スペクトルを取得する為、時間がかかります
PとBの指定が困難である場合(スペクトルが安
定しない、ピーク強度が小さいなど)、スペクトル

を波形分離にかけて線分析する場合などはこち
らを使います

上段が取得しているスペクトル
中段がスペクトルの微分形
下段が微分形を元にした強度/ピク
セルのline profileグラフで、左側の

ピクセルから徐々に線分析が進ん
でいきます

スペクトル中の微分形の極大-極小値の差分
が強度になります
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オージェ分析 depth profile

１．分析エリアの取り込み
wide scan参照。必ずユーセントリック位
置に合わせてください

２．分析条件の設定 
オージェマスター→ AES → Depth profile→ 

Depth profileでウィンドウが立ち上がります。
Analyzer ConditionでAnalyzer mode, Number 
of Cycles, Auto Probe Trackingを設定 (利用時) 
• Number of CyclesはAr⁺エッチングと分析のセットを何回行うかです。
なお、初回は必ずAr⁺エッチングなしの分析になります

• Auto Probe Trackingはステップの種類をCycles、ROI、Sweepsから選
択出来ます。動きすぎない時間間隔に指定してください

• どのくらいの深さ間隔で削って分析していくべきかですが、オージェ
は表面から2 nm ほどの深さから出てくる電子がスペクトル全体の9
割を占めています。そのため、2 nm 刻みでデプスプロファイルを実

行出来ればほぼ取りこぼしがないと言えます。各チャンネルエッチ
ングレートと材料のエッチングレートを勘案してCyclesやetching 
timeなどを適切に指定してください

• またAr⁺エッチングを用いて深さ方向に対する化学状態の変移を見
たい場合はAr⁺エッチングによる影響での化学状態の変化がない
かどうか検証した方がいいでしょう

４．ROIの設定 split scan参照

３．分析箇所の設定 wide scan参照

５. イオン銃の設定
Ar⁺エッチングを参照してArガスの導入、ガス圧の調整を行います
Depth profile→Conditions→Ion Gun Controlでエッチング設定ウィ
ンドウを立ち上げます。上部のEtchingメニューでエッチング条件の
Channel番号を選択します

Stage RotationでOffかOne-wayのどちらかを選択
Ar⁺エッチングを一方向から照射し続けると表面が荒れやすい為、ステージを回転させながら

照射する事で荒れを軽減させます。回転後に位置ズレが起きやすいので細かい分析位置を指
定している場合はOff推奨 26



オージェ分析 depth profile

中段にあるDepth Profile and Cross-
sectionでEtching TimeとRelaxation Time
を入力

Relaxation TimeはAr⁺エッチング後に用意される緩
和時間です(表面電場に対する)。大体10秒ほどに設
定してください

UsingをOnにし、Depth Presetをクリッ
クするとEtching Time Tableが現れます。
Cycleごとに個別のエッチング時間を設
定する事が出来ます

６．Auto probe trackingの設定
wide scanを参照、ステージを回してると画が追え
ない可能性が高いです

７．予備測定
wide scanを参照。エッチングは行われません

８．本測定
Acquisitionでstartします。上段に各

ROIのスペクトル、中段に微分形、下段
に各ROIが色付けされてIntensity/cycle
のグラフが出てきます

Sputter ConditionsにはAr+イオンガン
の状態が表示されます
測定中に上部メニューでCycle、各ROI
のSweep、エッチング時間を変更する
事が出来ます
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オージェ分析 auger image
１．分析エリアの取り込み

長時間測定になるのでSEMの取り込みはImage Fine 
Shiftを初期値に戻してAuto probe trackingの機能が万全
に使えるようにしてから行ってください

２．分析条件の設定 
AES → Auger Image→ Auger Imageでウィ
ンドウが立ち上がります。Analyzer modeと
Auto Probe Trackingを設定します（wide 
scan参照）
３．分析箇所の設定

Auger Image→ Condition→ Analysis  area 

で取り込んだ画像から分析位置を指定しま
す。Selectionで全体か領域指定を選びます。

指定する場合はマウスでドラックします。
Resolutionで解像度を指定します

解像度を倍にすると測定時間は4倍です

４．ROIの設定
split scan, line profileを参照
PとBを取得して強度の定義に従い、画を
作ります。PとBの取得方法はPB別法、PB同
時法から選べます

PB別法よりPB同時法をお勧めします。PB別法は倍の時

間がかかるので長時間測定になります。またマッピング
のPB同時法による測定だとimage investigatorであとから
各チャンネルのP及びBの設定を変更する事が可能であり、
analyzer modeの違いによるピーク、バックグラウンドのズ
レによるP,Bの取得ミスをある程度修正出来ます

６．Auto probe trackingの設定 wide scan参照

８．本測定
各元素のスキャンの一回目が終わってからデータを操作
する事が出来ますので、PBの設定が問題ないかどうか
image investigatorで確認してください(PB同時法の場合)

28
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オージェ分析 spectrum image

spectrum imageはAuger masterに新たに追加されたマッピング用の測定法で
す。前頁で紹介した従来のauger imageと異なり、視野内の全ピクセルでスペクト

ルを順次測定します。スペクトル情報を持ったキューブデータからマッピング像
作成や指定視野のスペクトル抽出などの再構築が行えます。ドリフト補正やノイ
ズ除去機能が優秀です。スキャンを続けて測定するため点分析時よりもビーム
ダメージを抑える事も可能です。測定には時間がかかりますが、視野全体の情
報を1度に網羅することが出来ます。測定したキューブデータは「EFSEMviewer」
というwindows上のソフトウェアで再構築を行います

１．分析エリアの取り込み
長時間測定になるのでSEMの取り込みはImage Fine 

Shiftを初期値に戻してAuto probe trackingの機能が万全
に使えるようにしてから行ってください

２．分析条件の設定 
AES → Spectrum Image→ Spectrum Imageでウィンド
ウが立ち上がります。Conditions → AnalyzerからAuto 
Probe Trackingのみ設定します（wide scan参照）
基本的にFrames単位で仕掛けて下さい

３．分析箇所の設定
分析箇所の設定はありません。取込画像が分析箇
所になります

４．ROI(Spectrum condition)の設定
データの保存先と名前をBrowseから指定します。指
定したディレクトリには各RangeのAugeｒ Image(.Aの
拡張子)が格納され、それらを統合したキューブデー
タが最終的に指定した名前(.jampの拡張子)で指定し
たディレクトリと同階層に作成されます。

Energy Rangeでスペクトルの取得範囲を設定します。
Analyzer ConditionからMode、Ep(M1使用時)、Dwell
を設定します。Pixel resolutionを設定します

仕掛けを作ると測定にかかる予測時間が更新され
ます

開始前にWindows上でSpectrumAlign(Online)が立ち上がっ
ている事を確認して下さい。なければWindowsのスタート画面

から立ち上げて下さい。このソフトウェアがキューブデータを
自動で作成します。SpetrumAlign(Offline)もあるので間違えな
いで下さい

Online用

Offline用
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オージェ分析 spectrum image
４．Spectrum conditionの設定(続き)

この測定では指定したRangeを順次、指定した
Modeのエネルギーステップと７つの検出器で測定
します
・M1の場合

Epの設定でエネルギーステップが決まり、測定エ

ネルギーには依存せず、等間隔のエネルギー幅で
走査します。高エネルギー側を細かく刻んで測定し
たい場合に向いています
・M2～M5の場合

測定エネルギーに依存し、不等間隔のエネル
ギーステップで走査します。M5がもっともエネル
ギー幅が広く、高感度で測定します。M2がもっとも
エネルギー幅が狭く、感度が落ちます。基本M5で

測定し、高エネルギー側でピークが隣接しているな
ど、エネルギー分解能を求める場合にはRangeを
絞って小さいモード番号を使うのが良いです

M1の場合

M5の場合

カ
ウ
ン
ト

データ取得のイメージ

エネルギー

1
ス
キ
ャ
ン

1スキャン

E₀-3ΔE

E₀+3ΔE

E₀

E'₀-3ΔE'

E'₀

E’₀+3ΔE'
５．イオン銃の設定

中和電子銃を照射しながら測定を行いた
い場合はP14、15を参照して照射して下さい

 

M2～M5の場合、
幅が広がっていく

６．Auto probe trackingの設定
wide scan参照。高倍率では使用しましょう

８．本測定
Acquisitionでスタートします。予備測定は
ありません。中断した場合、そこまでのデー
タでキューブデータが作成されます
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トランスファーベッセル(利用時は確認する事)

トランスファーベッセルを利用して試料導入を大気非暴露
で行う事が出来ます。使用する場合は必ずスタッフに連絡し
て下さい

トランスファーベッセル
(輸送ケース装着)

大気非暴露用
試料ホルダー

グローブボックス内での作業

1. 試料をホルダーに固定する

2. 輸送ケースのストッパーを外し
てトランスファーベッセルを輸送
ケースから取り出す

3. トランスファーベッセル開閉ノブ
を回してOPENにする

4. トランスファーベッセルに試料ホ
ルダーを設置

5. トランスファーベッセル開閉ノブ
を回してCLOSEにする

6. ガイドピンを合わせてトランス
ファーベッセルを輸送ケースに
装着し、ストッパーを締める

ストッパー

ガイドピン

CLOSE状態

真空に引く部分は汚さないで下さい

AESでの作業

1. 試料導入室をVENT

2. ブランクフランジの固定用
つまみを緩め、ストッパー
を外側にスライドさせ、ブ
ランクフランジを取り外す

3. 外したフランジはアルミホ
イルで包む

ブランクフランジ
ストッパー

固定用つまみ
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AESでの作業

4. 輸送ケースからトランスファーベッセ
ルを取り出し、ガイドピンを合わせて
試料準備室上部に取り付ける。ストッ
パーを内側に寄せて再度設置する

5. 試料準備室の扉を閉めてVENTボタン
を押して真空引きを行う

6. 装置のオペレータ板を外して試料準
備室の真空計を確認。1×10-4Paまで
待つ

7. TMP OFFボタンを押す。マグネットリン
グが後退していることを確認

8. ベッセルの開閉ノブを時計方向に回し
てベッセルを排気できる程度に慎重に
開く(必ずTMP停止してから開くこと）

9. TMP OFFボタンをもう一度押して再排
気を始める。真空計の針が完全に0に
到達するまで真空を引く

10.ベッセルをOPENまで開き、窓から覗き

ながらマグネットリングを操作して試
料ホルダーを取り出す。マグネットリン
グを後退させ、ベッセルをCLOSEまで
締める

11.通常の試料導入手順に沿って、分析
室に試料ホルダーを送る

12.もう一度、ベッセルをOPENまで開く

トランスファーベッセル
取り付け

試料準備室真空計

TMP OFFボタン

トランスファーベッセル(利用時は確認する事)
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分析後、取り付けたままのベッセルに試料を回収する場合

1. OPEN状態のベッセルを締めてCLOSEに変更する

2. 通常の終了手順に則って試料導入室まで試料ホルダー
を取り出す

3. ベッセルを開閉ノブでOPENに変えてMGLを操作し、ベッ
セルに試料ホルダーを設置

4. ベッセルをCLOSEまで締める
5. 試料導入室をVENTする

6. 試料導入室上部の固定用つまみを緩め、ストッパーを外
側にスライドさせ、ベッセルを取り外す

7. ブランクフランジを取り付けてストッパーを設置して固定
する

8. 試料導入室の扉を閉めてロックしてからVENTボタンを押
して真空引きを行う。他は終了手順参照

トランスファーベッセル(利用時は確認する事)



終了の仕方
• まず初めに

ハードウェア・ソフトウェア上の各パラメータを始めの状態に戻します
(・加速電圧10kV ・対物絞り4番 ・SEMモード番号0番 ・Analyzer Mode M5 
・Auto Probe Tracking Off ・ダイナミックフォーカス Offに戻す など)

• Ar⁺イオンガンを使っている場合
試料の取り出しより先にArガスの導入を止めてください
・オートバルブコントローラーのスイッチをOfｆ
・Arガスバルブを時計回りに1/4回転回す(9時方向)
・冷却時間として3分待つ
・Arガスバルブを時計回りに3/4回転回す(6時方向)

• 反射電子検出器を利用またはEBSD測定をしている場合
ステージの試料交換位置への移動の前に反射電子検出器及び
EBSDカメラを抜いて元に戻して下さい。特にEBSDカメラは必ず先にカ
メラを抜いて下さい。ステージを先に戻すとカメラと衝突します

• ステージを試料交換位置へ移動
導入時と同様にsample  manipulation →special positionを選択し、
Moveをクリックしてホルダー選択

• 試料の取り出し前
2次電子検出器はOFF、PCDはIN、ビームシャッターは閉じます。分析
室の窓蓋を外し、中を覗けるようにする

• 試料の取り出し
V2ボタンを押してV2バルブ解放、マグネットリングを前方へ押し出し、
ホルダーをキャッチ。マグネットリングをOpen→Closeへ回してからリ
ングを一番後ろまで引き抜き、再びV2ボタンを押します。必ず分析
室内を目視確認する事。試料導入室のロックを外し、VENTボタンで
大気圧へ戻します。分析室の窓蓋を再びつける

• 試料の取り出し後
VENTボタンをもう一度押して、試料導入室を必ず真空に引き直す。
ホルダーは洗浄後、デシケーターへ。データはオージェ解析用PCの
ネットワークからアクセスして回収して下さい。装置PCはSEMソフト

ウェア、オージェマスターは開いたまま、ディスプレイの電源だけ消
す。分析室真空度をチェックし、記録簿に残りの項目を記入 34
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